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> Six Sigma Champion
Six Sigma kennenlernen und Projekte initiieren

> Six Sigma Green Belt 
Prozesse systematisch verbessern

> Six Sigma Black Belt 
Komplexe Projekte managen

> Six Sigma Master Black Belt 
MitarbeiterInnen trainieren & Projekte coachen

Alle Trainings werden mittels eLearning unterstützt, um 
Ihren Wissenszuwachs nachhaltig zu stärken. Greifen Sie 
dazu beispielsweise auf Business Cases, das Glossar und 
eine Auflistung der wichtigsten Fragestellungen mit deren 
Antworten zu. Oder kontaktieren Sie ExpertInnen, posten 
Sie im Blog - nutzen Sie die Interaktivität des eLearnings.

> Design of Experiments 
Statistische Versuchsplanung

> Failure Method Effects Analysis 
Fehler-, Möglichkeits-, Einfluss-Analyse

> Quality Function Development 
Produkte besser an Kundenwünsche anpassen

> Design for Six Sigma 
Six Sigma in der Entwicklung

3

Praxisberichte sind Informationsveranstaltungen mit Refe-
rentInnen aus Unternehmen unterschiedlicher Branchen. 
Hier lernen Sie Best Practice Beispiele kennen und können 
sich zum Thema Six Sigma informieren oder austauschen. 
Ihre Fragen können Sie auch direkt an die TrainerInnen der 
Six Sigma and Innovation Academy oder an MitarbeiterInnen 
der Donau-Universität Krems stellen. Machen Sie sich mit der 
Thematik vertraut oder erweitern Sie Ihr Wissen! 

> Six Sigma and Innovation Academy

>

Basis
Champion 
Training

2 Tage

Aufbau 1
Green Belt

Training

2 Tage 
+ 3 Tage
+ 1 Tag 
= 6 Tage

Aufbau 2
Black Belt 

Training

3 Tage 
+ 3 Tage
+ 3 Tage
+ 3 Tage
+ 2 Tage
+ 1 Tag 

= 15 Tage

Vertiefung
DOE

3 Tage

Vertiefung
FMEA

1 Tag

Vertiefung
QFD

1 Tag

Vertiefung
Design for
Six Sigma

+ 3 Tage
+ 3 Tage 
= 6 Tage

Statistische
Einführung

DFSS

1 Tag

Aufbau 3
Master 

Black Belt 
Training

2 Tage 
+ 2 Tage
+ 1 Tag 
+ 1 Tag 
= 6 Tage

DMAIC Prozessablauf

Praxisberichte

DMADV 
Prozess-
gestaltung

2

Six Sigma eAcademy > eLearning >   WIKI > Moodle > Videocasts > Glossar
Business Cases > Blog > Coaching   > Downloads > ExpertInnen > Fragen



Die Six Sigma Methode wurde entwickelt, um die Abläufe 
im Unternehmen effizient zu verbessern. Dabei werden 
nicht nur Kosten eingespart, sondern auch die Qualität der 
Produkte oder Dienstleistungen gesteigert.

Bekannt wurde Six Sigma durch die Erfolge, die global agie-
rende Konzerne wie General Electric, Motorola, ABB, Bom-
bardier u.v.m. damit verbuchen konnten.

Die Six Sigma and Innovation Academy der Donau-Universi-
tät Krems bietet eine praxisnahe Ausbildung in 3 Stufen an. 
In Six Sigma gibt es verschiedene Rollen, die angelehnt an 
asiatische Kampfsportarten, nach Gürteln (Belts) definiert 
sind. Dazu können vertiefende Module gebucht werden, 
die eine Spezialisierung erlauben. 

Six Sigma ermöglicht es Unternehmen, nachhaltig ihre 
Ergebnisse zu verbessern, die Kundenzufriedenheit 
auszubauen und dabei Kosten einzusparen. Die Six Sig-
ma Academy  bietet dazu eine fundierte Ausbildung, die 
sofort in der Praxis angewendet werden kann und so Ihr 
Unternehmen fit für die Zukunft macht. Moderne Lernme-
thoden wie eLearning  reduzieren die Abwesenheit des Mit-
arbeiters aus dem Unternehmen auf ein notwendiges Mini-
mum. Anhand von Business Cases wird das theoretische 
Wissen auf verschiedene Szenarien umgelegt und so ein 
umfassendes Verständnis der Methoden möglich.

Kooperationspartner

Die Donau-Universität Krems arbeitet für die Six Sigma and 
Innovation Academy mit der MCG Managementberatung 
GmbH zusammen. So wird garantiert, dass der hohe uni-
versitäre Anspruch von Experten aus der Praxis untermau-
ert wird. 

Die MCG wurde 1998 von einer Gruppe erfahrener Füh-
rungskräfte aus der Industrie und langjährigen Beratern 
gegründet.  Wir sind eine international ausgerichtete, stark 
wachsende Beratungs- und Management auf Zeit Gesell-
schaft. Wir arbeiten für unsere Kunden in nahezu allen eu-
ropäischen Ländern - von Neapel bis Stockholm bzw. von 
London bis Moskau. 

Der Schwerpunkt unserer Tätigkeiten ist Performance Im-
provement für Industrie und Dienstleistungen. Unser Lei-
stungsportfolio umfasst Strategieentwicklung, Innovation 
und Prozessmanagement. 

Durch Kooperationen mit Universitäten (Stanford Univer-
sity, Palo Alto, Johannes Kepler Universität Linz, Donau-
Universität Krems) stellen wir  Innovationen in unserem 
Leistungs-Portfolio sicher. 

Unser Job ist es, eine nachhaltige und substanzielle Ver-
besserung Ihrer Performance zu erreichen. We make things 
happen! 
www.mcg-experts.com

> Six Sigma and Innovation Academy
Prozesse erfolgreich optimieren

Dieses Einstiegsmodul macht die TeilnehmerInnen mit dem 
Ansatz von Six Sigma vertraut und sie lernen die Sprache 
von Six Sigma kennen. Six Sigma nützt statistische Tools 
zur Prozessverbesserung. Somit können unternehmens-
wichtige Entscheidungen aufgrund von Zahlen und Fakten 
gefällt werden. Konkrete Messungen ersetzen somit Mei-
nungen und machen damit Entscheidungen stichhaltiger.  

Nutzen
Sie lernen die Ziele von Six Sigma kennen sowie die Erfolgskriterien 
dieser Methode. Sie werden in die Grundlagen des Prozessdenkens 
eingeweiht und lernen Prozesse zu bewerten. Weiters wird Ihr Ver-
ständnis für die Projektarbeitsmethodik durch spezifische Praxisbei-
spiele geschult. Neben den Grundlagen der angewandten Statistik 
erfahren Sie wie Sie Datenanalysen graphisch aufbereiten. Sie ermit-
teln die Verbesserungs-Potenziale von Prozessen und können die dazu 
notwendigen Projekte initiieren. Dieses Training unterstützt Sie bei der 
Beurteilung, welche Projekte in Ihrem Unternehmen mit der Six Sigma 
Methode bearbeitet werden können. 

Zielgruppe
BereichsleiterInnen, AbteilungsleiterInnen und Teammitglieder, die 
künftig im Six Sigma Prozess mitarbeiten sollen. Führungskräfte, in 
deren Unternehmen Six Sigma angewandt wird, können sich mit die-
sem Training mit der Sprache von Six Sigma vertraut machen. 

Inhalte
> Six Sigma: Geschichte, Gegenwart, Zukunft
> Erfolgsfaktoren der Six Sigma Methode
> Zielsetzung von Six Sigma
> Prozessdenken und Prozessbewertung
> Grundlagen der angewandten Statistik
> Grafische Verfahren der Datenanalyse
> Projekt- und Personalmanagement
> Beispiele erfolgreicher Six Sigma Programme

> Six Sigma Champion Training
Die Six Sigma Sprache kennenlernen und Six Sigma Projekte initiieren

> Start
 Frühjahr 09.03.2009 
 Herbst 03.09.2009

> Dauer
 2 Tage

> Abschluss 
 Teilnahmebestätigung

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR  1.120,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>Prozesse 
erfolgreich 
optimieren
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> Six Sigma Green Belt Training
Prozesse systematisch verbessern

Green Belts sind MitarbeiterInnen, die an Six Sigma Pro-
jekten mitarbeiten sollen. Aufbauend auf dem Champion 
Training tragen Sie systematisch und fachkundig zur Verbes-
serung  der Prozesse im Unternehmen bei. Durch Six Sigma 
können Problemstellungen in einem kurzen Zeitraum ziel-
spezifisch abgearbeitet werden. Außerdem wird mit Six Sig-
ma ein nachhaltiger Kulturwandel im Unternehmen vollzo-
gen. Produktivitätssteigerung und Erhöhung des EBITs sind 
einige der Anwendungsgebiete dieser Methode. Six Sigma 
kann sowohl in Entwicklung  und Produktion angewendet 
werden, als auch administrative Prozesse und Dienstlei-
stungen optimieren. Green Belts unterstützen Black Belts 
dabei komplexe Prozesse abzuwickeln.

Nutzen
Sie lernen die wichtigsten Methoden von Six Sigma kennen und sam-
meln erste Erfahrungen im ausbildungsbegleitenden Praxis-Projekt. 
Sie präsentieren Ihr Projekt in der Abschlussprüfung. Als Green Belt 
können Sie an Six Sigma Projekten Ihres Unternehmens mitarbeiten 
und kleine Projekte selbst leiten. Sie lernen den „klassischen“ Six 
Sigma Projektablauf mit DMAIC (Define, Measure, Analyze, Improve, 
Control) kennen. 

Zielgruppe
Ausgewählte MitarbeiterInnen aus Fachbereichen, die künftig mit Six 
Sigma an der  Prozessoptimierung mitarbeiten sollen. Vor allem Inge-
nieurInnen, EinkäuferInnen, PlanerInnen und MeisterInnen  profitieren 
von dieser Ausbildung.

Inhalte
> Hilfsmittel zur Ursachenanalyse
> Grafische Methoden
> Messmittelfähigkeit
> Streuung, Fähigkeit und Verbesserung in der Prozessführung
> Prozessverbesserungsplan
> Datenanalyse mit EXCEL
> Grundlagen der angewandten Statistik
> Einführung in die Hypothesentests
> Korrelation, Varianzanalyse
> Midelldiagnosen und Bewertungen der praktischen Signifikanz
> Multi Vari-Studie
> Praktische Anwendungen anhand von Fallstudien
> Praxisprojekt

> Start 
 Frühjahr 09.03.2009  
 Herbst 03.09.2009

> Dauer
 5 Tage 
 + Prüfungstag

> Abschluss 
 Zertifikat

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR 2.700,00  
 Prüfungstaxe EUR 190,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>

Black Belts sind Verbesserungsexperten die Projektmana-
gement-Aufgaben übernehmen. Sie haben eingehende 
Kenntnisse über die Anwendung der Six Sigma Methoden. 
Sie können Verbesserungsprojekte durchführen. Ziel des 
Black Belts ist ein Verbesserungsprojekt pro Jahr mit einer 
Kostenersparnis von EUR 200.000,- (abhängig von Unter-
nehmensgröße) durchzuführen. Black Belts sind die Schlüs-
selpersonen im Six Sigma Prozess. Als Methodenspezia-
listen haben sie umfangreiches statistisches Wissen, das 
zur Lösung komplexer Aufgabenstellungen herangezogen  
werden kann. Darüber hinaus können Sie Problemlösungs-
Teams führen.

Nutzen
Sie lernen wie Sie komplexe Problemstellungen anpacken und lösen 
können. Sie vertiefen die theoretischen Fertigkeiten, um anspruchs-
volle Projekte erfolgreich zu bewältigen. Auch in dieser Stufe der Aus-
bildung führen Sie ein Praxis-Projekt durch und präsentieren es  in der 
Abschlussprüfung.

Zielgruppe
MitarbeiterInnen, die anspruchsvolle Projekte alleine und mit Hilfe der 
Green Belts lösen sollen.

Inhalte
> T-Test, F-Test, Chi2-Test
> Konfidenzbereiche
> Multi-Faktoren Varianzanalyse (ANOVA inkl. Wechselwirkungen)
> Multiple Regression
> Logistische Regression
> Prinzipielle Versuchsmethoden
> Versuchspläne DOE (vollfaktionell, teilfaktionell, 2k-faktionell)
> EVOP Evolutionary Operations
> Response Surface Design
> Power and Sample Size
> Kovarianzanalyse
> Lean Tools
> Moderation und Kreativität
> Regelkarten (SPC)
> Six Sigma Tools der Simulation
> Quality Function Deployment
> Projektreviews

> Six Sigma Black Belt Training
Komplexe Projekte managen

> Start
 Herbst 12.10.2009
 

> Dauer
 14 Tage 
 + Prüfungstag

> Abschluss 
 Zertifikat

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR 9.400,00  
 Prüfungstaxe EUR 190,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>
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> Six Sigma Master Black Belt Training
MitarbeiterInnen trainieren & Projekte coachen

Six Sigma Master Black Belts sind die technischen und or-
ganisatorischen Führer des Lean Six Sigma Programms. 
Sie sind die „Master Minds“ der Verbesserung sämtlicher 
Bereiche des Unternehmens und verbreitern ständig die 
Wissensbasis der MitarbeiterInnen. Ziel des Trainings ist, 
die TeilnehmerInnen zu befähigen, eine Six Sigma Initiative 
im Unternehmen zu starten, erfolgreich zu implementieren 
und die Nachhaltigkeit sicherzustellen.

Nutzen
Sie erhalten in sechs Tagen ein vertiefendes Verständnis über Six Sig-
ma. Sie können Projekte coachen, Sie beherrschen das Arbeiten mit 
Projektteams und trainieren MitarbeiterInnen. Als Six Sigma Master 
Black Belt haben Sie im Unternehmen eine herausragende Stellung.

Zielgruppe
Six Sigma SpezialistInnen (zertifizierte Six Sigma Black Belts) die min-
destens fünf nachweisbar erfolgreich abgeschlossene Projekte vor-
weisen können.

Inhalte
> Wiederholung und Vertiefung der Lean Six Sigma Methoden
> Unterstützung von Six Sigma Green und Black Belts
> Coaching von Six Sigma Projekten
> Weiterentwicklung und Adaption der Six Sigma Methodik 
 zur optimalen Anwendung auf die strategischen Geschäfts-
 erfordernisse
> Integration von Six Sigma, Design for Six Sigma und Lean Tools.
> Trainieren der Six Sigma Green und Black Belts

Anforderungen an den zukünftigen Master Black Belt

Als Six Sigma Master Black Belt haben Sie folgende Fähigkeiten: 
> Sie verstehen rasch neue Geschäftsprozesse. Sie verfügen
 über vertiefendes Verständnis bestehender Geschäftsprozesse.
> Sie beschreiben Probleme anhand von Zahlen, Daten und
 Fakten.
> Sie können das eigene Wissen vermitteln und geben es an   
 andere weiter.
> Sie verstehen die zu analysierenden Daten  und interpretieren  
 die Analyseergebnisse richtig.
> Sie erkennen Probleme bzw. Konfliktsituationen und lösen   
 diese.
> Sie identifizieren Key Player im Unternehmen und binden diese  
 mit ein.

> Termin 
 auf Anfrage

> Dauer
 5 Tage 
 + Prüfungstag

> Abschluss 
 Zertifikat

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR 3.680,00  
 Prüfungstaxe EUR 190,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>

Die DOE Methode basiert auf Versuchsreihen in denen In-
putvariable (z.B. Produkt- bzw. Prozesskomponenten oder 
-eigenschaften) verändert werden und deren Auswirkung 
auf den Output dargestellt wird. Dies erlaubt Vorhersage-
modelle mit multiplen Variablen zu generieren, die wesent-
lichen Hebel zur Verbesserung zu erkennen und Störgrößen 
zu identifizieren. Somit führen weniger Versuche zu besse-
ren Ergebnissen. Alle Produkt- und Prozessanforderungen 
können in kürzester Zeit zu minimalen Kosten erfüllt werden.

Die DOE Methode führt zu nachweislich verbesserten Pro-
dukten und entwickelt effizientere Prozesse. Die Anwen-
dung schlagkräftiger statistischer Methoden unterstützt Sie 
in der raschen Lösung von Fertigungsproblemen.

Nutzen
Sie erhalten in drei Tagen ein umfangreiches Know-how über die DOE 
Methodik und den idealen Ablauf bei der Durchführung. Durch prak-
tische Beispiele lernen Sie Versuchspläne zu erstellen und Versuche 
durchzuführen. Sie werten Versuchsergebnisse aus und interpretieren 
diese Ergebnisse. Sie beherrschen die statistischen Werkzeuge des 
DOE Zyklus und können statistische Versuchsplanung als ganzheit-
lichen Prozess im Unternehmen einführen.

Zielgruppe
IngenieurInnen, TechnikerInnen und FachbereichsleiterInnen die in 
den Bereichen Prozessoptimierung, Produktentwicklung oder Quali-
tätssicherung arbeiten. Führungskräfte und MitarbeiterInnen, die eine 
Systematik zur Verbesserung des Versuchsaufbaus einführen wollen.

Inhalte
> Einführung in die Versuchsplanung
> Statistische Grundlagen - Hypothesentests und Varianzanalyse  
 (ANOVA)
> Statistische Versuchspläne
 > Vollfaktorielle Versuchspläne
 > 2k-faktorielle Versuchspläne
 > Teilfaktorielle Versuchspläne
 > Versuchspläne mit Center Points zum Auffinden nicht line-
  aren Verhaltens
> Response Surface Designs (Optimierungsversuchspläne) mit  
 mehreren Zielgrößen
> Evolutionary Operations (Versuchspläne im laufenden Prozess)

> Design of Experiments (DOE) Training
Statistische Versuchsplanung

> Termin  
 11.-13.05.2009

> Dauer
 3 Tage

> Abschluss 
 Teilnahmebestätigung

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR  1.440,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

Prozesse 
effizient 
verbessern
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> FMEA (Failure Mode Effects Analysis) Training
Fehler-, Möglichkeits-, Einfluss-Analyse

Die FMEA ist eine präventive Methode zur Bewertung und 
Minimierung von Risiken in Systemen. Durch Anwendung 
dieses systematischen Verfahrens werden gezielt poten-
zielle Fehler bewertet und Maßnahmen eingeleitet, damit 
diese Fehler gar nicht erst auftreten. Potenzielle Fehler wer-
den anhand von Fehlerbedeutung, Auftretens-Wahrschein-
lichkeit und Entdeckungs-Wahrscheinlichkeit gewichtet.

Nutzen
Sie erhalten in diesem Intensivtraining einen umfangreichen Einblick 
in die Methodik der FMEA und können die FMEA im eigenen Unter-
nehmen als Moderator eines Teams durchführen. Sie lernen Verbes-
serungs-Maßnahmen unter Berücksichtigung der Risikoprioritätszahl 
abzuleiten. Dadurch lässt sich Prozess-Unsicherheit reduzieren und 
die Prozess-Stabilität nachhaltig steigern. 

Zielgruppe
MitarbeiterInnen, die in den Bereichen Prozessoptimierung, Produkt-
entwicklung oder Qualitätssicherung arbeiten. Führungskräfte und 
MitarbeiterInnen, die eine Systematik zur Prozessbewertung und Risi-
kominimierung suchen.

Inhalte
> Einführung in die FMEA
> Einsatzmöglichkeiten der FMEA
> Zeitpunkt der FMEA Einführung
> Aufgaben der FMEA
> Verbindung zur Ursache-Wirkungs-Matrix (C&E Matrix)
> System FMEA, Konstruktion FMEA, Prozess FMEA
> FMEA Formblatt
> Durchführung der FMEA
> Case Study (Fallbeispiel) 

Ziele der FMEA
> Frühzeitige Erkennung und Lokalisierung von Fehlern an 
 Produkten und Prozessen
> Risiken vermeiden bzw. vermindern
> Kosten für Gewährleistung und Imageverlust werden vermieden
> Verkürzung der Entwicklungszeiten

Anwendungsgebiete der FMEA
> Neuentwicklung eines Produktes
> Einsatz neuer Fertigungsverfahren 
> Beurteilung von Sicherheits- und  Problemstellungen
> Produktänderungen
> Geänderte Einsatzbedingungen vorhandener Produkte/Prozesse

> Termin  
 09.06.2009 
 

> Dauer
 1 Tag

> Abschluss 
 Teilnahmebestätigung

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR  540,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>

Das QFD ist ein System aufeinander abgestimmter Pla-
nungs- und Kommunikationsprozesse um Entwicklungs-
zeiten zu reduzieren und die erwünschten Kundenanfor-
derungen zu erfüllen. Dabei werden etwaige Zielkonflikte 
und Verkaufsschwerpunkte bzw. technische Herausfor-
derungen berücksichtigt. QFD wurde von Yoji Akao und 
Katsuyo Ishihara um 1969 entwickelt, um Produktkonzepte 
besser mit den Kundenwünschen in Einklang zu bringen. 
1974 begann Toyota  mit der gezielten Anwendung von 
QFD bei der Einführung neuer Fahrzeugmodelle. Seitdem 
hat sich die Anwendung des QFD massiv erweitert. [Ste-
phan Lunau, Design for Six Sigma + Lean Toolset]

Nutzen
Sie lernen anhand der Houses of Quality (HOQ) Entwicklungsaufgaben 
strukturiert zu bewältigen. Sie verstehen den klassischen, 4-stufigen, 
QFD Zyklus und können diesen im eigenen Arbeitsumfeld erfolgreich 
anwenden. Sie erhalten umfangreiches Know-how über die Einsatz-
möglichkeiten des QFD. Sie lernen an praxisorientierten Beispielen, 
ein umsetzungsorientiertes Arbeiten mit dieser seit Jahren erfolgreich 
praktizierten Methodik. Dabei erwerben Sie Wissen, um den Wandel 
vom möglichkeitsorientierten zum zielorientierten Arbeiten zu mei-
stern und die notwendigen Features bei Produkten (z.B. Verbrauch 
eines Motors, Gewicht oder Größe eines Bauelements, Leistungspa-
rameter) oder im Prozess zu realisieren.

Zielgruppe
IngenieurInnen, TechnikerInnen und FachbereichsleiterInnen die in 
den Bereichen Prozessoptimierung, Produktentwicklung oder Quali-
tätssicherung arbeiten. Führungskräfte und MitarbeiterInnen, die eine 
Systematik zur Verbesserung des Entwicklungsprozesses einführen 
wollen.

Inhalte
> Einführung in das Quality Function Deployment
> House of Quality als Kernelement im Rahmen des QFD
> Einsatzgebiete und Beteiligte am QFD Prozess
> Vorgehensmodell im Rahmen des QFD Prozesses
> Kundenanforderungen und kritische Qualitätsmerkmale 
 (Kano Modell)
> Optimierungsrichtungen, Bewertung der Konkurrenzfähigkeit,  
 Sollprofil und Verkaufsschwerpunkte
> Erstellung Beziehungsmatrix
> Technischer Produktvergleich und Zieldefinition
> Technische Wechselbeziehungen
> Bewertung der technischen Herausforderungen
> Ergebnisinterpretation
> Übungsbeispiele 

Zielsystem von QFD
> Quality: Instrument zur Planung und Entwicklung von Prozess-  
 oder Produktfunktionen gemäß den Kundenanforderungen.
> Function: Qualitätsentwicklung und -verbesserung durch syste- 
 matische und stimmige Zusammenarbeit aller Funktionsbereiche.
> Deployment: Aufgliederung der geforderten Qualität in spezi-
 fische Zielvorgaben für einzelne Prozessstufen und Unterneh-
 mensbereiche.
> Dies geschieht über einen üblicherweise 4-stufigen Prozess   
 indem mehrere Qualitätshäuser (Houses of Quality) sequenziell  
 miteinander verknüpft werden.

> Quality Function Development (QFD)
Produkte besser an Kundenwünsche anpassen

> Termin  
 09.06.2009 
 

> Dauer
 1 Tag

> Abschluss 
 Teilnahmebestätigung

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR 540,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>
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> Design for Six Sigma 
Six Sigma in der Entwicklung

Design for Six Sigma (DFSS), ist die Produkt- und Prozess-
gestaltung mit Six Sigma und wird mittels strukturiertem 
DMADV (Define, Measure, Analyze, Design, Verify) Ablauf 
umgesetzt. Wie beim „klassischen“ Six Sigma Projektab-
lauf mit DMAIC (Define, Measure, Analyze, Improve, Con-
trol), werden spezifische Werkzeuge in jeder Phase einge-
setzt, die zu einer stark steigenden Effizienz in Produkt- und 
Prozessentwicklungsprozessen führen. 

Nutzen
Sie lernen für Ihre Kunden optimale Produkte zu entwickeln. Dabei 
wird besonders auf ein ideales Preis-Leistungsverhältnis geachtet. Ziel 
ist es, Prozesse und Produkte so zu optimieren, dass Services ange-
boten werden, für die der Kunde bereit ist zu zahlen. Sie erfahren wie 
Sie die Risiken in der Produktentwicklung, durch einen stringenten 
Projektablauf, so gering wie möglich halten können. Sie können kurze 
Time to Market sicherstellen. Sie lernen effektive Werkzeuge und eine 
einheitliche Sprache  kennen, die im Projektteam die Mitarbeitermoti-
vation erhöht. Damit wird die Sicherheit in jeder Phase des Projektes 
gewährleistet.

Zielgruppe
Techniker und Betriebswirte im Bereich der Prozess-, Produkt- und 
Unternehmensentwicklung sowie Green Belts und Black Belts.

Inhalte des DFSS Trainings

Einführung in Design for Six Sigma (DFSS)

Define Phase
> Projekte initiieren (Re-Design, Neu-Design)
> Projekte managen (RACI-Chart, Kostenplanung, Risikoabschät-
 zung, Define Gate Review)

Measure
> Kunden auswählen (ABC-Klassifizierung, Portfolioanalyse,   
 6-W-Tabelle)
> Kundenstimmen sammeln (Kundeninteraktionsstudie, Fokus-
 gruppeninterview etc.)
> Kundenbedürfnisse spezifizieren (CTQs, Affinitätsdiagrammm,  
 Baumdiagramm, Kano-Modell, Quality Function Deployment
 Phase 1/QFD Phase 1, Design Scorecard, Measure Gate Review)

Analyze
> Designkonzept identifizieren (QFD Phase 2, Kreativitätstech-
 niken, Benchmarking, Pugh Matrix, Conjoint Analyse)
> Designkonzept optimieren (TRIZ/TIPS, ARIZ, Stoff-Feld-Analyse, 
 Trimming, Ableitung notwendiger Ressourcen)
> Fähigkeiten des Konzepts überprüfen (Fehler-Möglichkeits-
 Einfluss-Analyse/FMEA, Antizipierende Fehlererkennung/AFE,  
 Vorbereitung Markteinführung, Analyze Gate Review)

Design
> Feinkonzept entwickeln, testen und optimieren (Transferfunk-
 tion, QFD Phase 3, Toleranz Design, Design for X, Hypothesen-
 tests, Design of Experiments/DOE, Risiken einschätzen und   
 vermeiden)
> Leistungsfähigkeit für Soll-Produktion überprüfen (QFD Phase 4)
> Prozessentwicklung (SIPOC, Value Stream Map/Spaghetti-
 Diagramm, Arbeits- und Verfahrensanweisungen, Ausrüstung  
 und Materialbeschaffung planen, Design Gate Review)

Verify
> Implementierung vorbereiten (KPI System, Prozessmonitoring)
> Prozess implementieren (Finale SOPs und Prozessdokumentation)
> Prozess übergeben (Projektabschluss, Verify Gate Review)

> Termin 
 03.-05.11.2009
 16.-18.11.2009

> Dauer
 5 Tage 
 + Prüfungstag

> Abschluss 
 Zertifikat

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR 2.480,00  
 Prüfungstaxe EUR 190,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

>

Dieser Workshop bietet Ihnen eine Einführung in die Sta-
tistik. An einem Tag erhalten Sie einen Überblick über die 
beschreibende (deskriptive) und schließende Statistik. 

Im Rahmen der deskriptiven Statistik lernen Sie die stati-
stischen Kennzahlen, wie Mittelwert, Median, Standardab-
weichung, Varianz, Quartile, Spannweiten etc. kennen. Sie 
lernen diese richtig zu interpretieren und verstehen deren 
Bedeutung in der Praxis. 

Im Rahmen der schließenden Statistik erhalten Sie eine 
Einführung in das Wesen von Hypothesentests und lernen 
deren praktische Umsetzung mittels Varianzanalyse.

Neben der Kalkulation von Kennzahlen mit Microsoft Excel, 
werden Berechnungen mit Hilfe der Statistiksoftware Mini-
tab durchgeführt.

Nutzen
Entdecken Sie die Aussagekraft von Daten. In diesem Workshop ler-
nen Sie die Statistik richtig zu interpretieren und praxisgerecht anzu-
wenden.

Zielgruppe
MitarbeiterInnen, die zahlenorientierte Entscheidungen zu treffen haben 
und alle, die gerne mit Zahlen, Daten und Fakten arbeiten.

> Einführung in die Statistik mit Minitab

> Termin 
 02.11.2009 
 

> Dauer
 1 Tag

> Abschluss 
 Teilnahmebestätigung

> Ort
 Donau-Universität Krems
 Dr.-Karl-Dorrek-Straße 30
 3500 Krems, Österreich

> Ihre Investition
 EUR  540,00

> Ihr Kontakt
 forumseminare@donau-uni.ac.at 

Kunden-
zufriedenheit 
ausbauen
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> Trainings 2009 
Termine und Preise

>

Weshalb ein Seminar besuchen oder doch einen Lehrgang wählen?

Die Weiterbildungsangebote im Zentrum für Wissens- und 
Informationsmanagement garantieren Ihnen die optimale 
Qualifikation, um sich rasch wechselnden beruflichen An-
forderungen anzupassen. Dabei ist für Sie der wesentliche 
Vorteil die relativ kurze Phase Ihrer Abwesenheitszeiten vom 
Unternehmen. Die Kombination von Fachkompetenz auf 
universitärem Niveau und aktuellem Know-how garantiert 
Ihnen, dass Sie das erworbene Wissen sofort in die Praxis 
umsetzen können. Abgestimmt auf die Thematik und Ihren 
Zeiteinsatz, können Sie Certified Programs mit Abschlus-
sprüfung und Seminare mit Teilnahmebestätigung besuchen. 

Alle Trainings können Sie auch als Inhouse-Seminare bu-
chen. Sie entscheiden, ob diese direkt in Ihrem Unterneh-
men oder an der Donau-Universität Krems abgehalten wer-
den. Wir empfehlen die zweite Variante, da Sie durch den 
räumlichen Perspektivenwechsel für neue Aspekte inspiriert 
werden. Natürlich können Sie die inhaltlichen Schwerpunkte 
auf die Bedürfnisse Ihres Unternehmens abstimmen. 

> Six Sigma Champion Training

> Six Sigma Green Belt Training

> Six Sigma Black Belt Training

> Six Sigma Master Black Belt Training

> Design of Experiments (DOE) Training

> FMEA (Failure Method Effects Analysis) Training

> Quality Function Development (QFD) 

> Design for Six Sigma 

09./10.03.2009
03./04.09.2009

09./10.03.2009
30.03.-01.04.2009
22.04.2009 (Prüfung)

03./04.09.2009
21.-23.09.2009  
08.10.2009 (Prüfung)

12.-14.10.2009
28.-30.10.2009  
09.-11.11.2009
01.-03.12.2009  
14./15.12.2009
12.01.2010 (Prüfung)

Auf Anfrage

11.-13.05.2009

09.06.2009

09.06.2009

03.-05.11.2009
16.-18.11.2009

2 Tage
2 Tage

5 Tage
+ Prüfungstag

5 Tage
+ Prüfungstag

14 Tage
+ Prüfungstag

5 Tage
+ Prüfungstag

3 Tage

1 Tag

1 Tag

5 Tage
+ Prüfungstag

EUR 1.120,00
EUR 1.120,00

EUR 2.700,00

EUR 190,00 Prüfungstaxe

EUR 2.700,00

EUR 190,00 Prüfungstaxe

EUR 9.400,00

EUR 190,00 Prüfungstaxe

EUR 3.680,00
EUR 190,00 Prüfungstaxe

EUR 1.440,00

EUR 540,00

EUR 540,00

EUR 2.480,00
EUR 190,00 Prüfungstaxe

Welche Vorteile erhalten Sie?

Sie erleben, 
> wie Sie praxisrelevante Themen und Inhalte gemeinsam 
 erarbeiten
> wie Sie durch moderne Lehrmethoden profitieren
> wie Sie die Verbindung von Wissenschaft und Praxis 
 erfolgreich umsetzen
> wie Sie begleitender Wissenstransfer unterstützt
> wie Sie kurze Ausbildungszeiten effizient in Ihren Arbeitsalltag  
 einbauen

Welche Themen können Sie wählen?

> Wissens- und Informations-Management
> Projekt-, Prozess-, Qualitäts- und Risiko-Management
> Change Management
> Six Sigma (Prozessablauf und -gestaltung)

>Die Anmeldung kann nur schriftlich bis eine Woche vor Ver-
anstaltungsbeginn storniert werden. Bei Abmeldung wird 
eine Stornogebühr von 20% der Seminargebühr verrech-
net. Wird ein/e Ersatz-TeilnehmerIn geschickt, entstehen 
keine zusätzlichen Gebühren. Ein/e Ersatz-TeilnehmerIn kann 
jederzeit genannt werden. 

Mehr Qualität - 
kürzere Durchlaufzeiten - 
weniger Kosten
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Die Donau-Universiät Krems ist spezialisiert auf universitäre Weiterbildung und bietet exklusive Aufbaustudien in den Bereichen • Wirtschaft und Manage-
ment • Kommunikation, IT und Medien • Medizin und Gesundheit • Recht, Verwaltung und Internationale Beziehungen • Kultur- und Bildungswissenschaften 
sowie • Bauen und Umwelt. Mehr als 3.700 Studierende aus 50 Ländern leben die Philosophie des Lifetime Learning und absolvieren ein Studium an der Univer- 
sität für Weiterbildung. Krems liegt – 80 km von Wien entfernt – in der einzigartigen Natur- und Kulturlandschaft Wachau, die zum Weltkulturerbe der UNESCO 
ernannt wurde.

Lifetime Learning.

www.donau-uni.ac.at/wim
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